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1 Executive summary 

In this report, a brief introduction is given to the URCHIN project, funded by the Northern Peripheries 

and Arctic Programme (NPA).  

We then describes the main techniques used for stock monitoring in sea urchin fisheries around the 

world, including techniques used in the NPA. These include methods for both surveying new fishing 

areas as well as scientific monitoring.  These include the use of SCUBA divers to undertake transect 

and/or quadrat studies of urchin size and frequency. Included in the report is a full description of the 

methodology used by Fisheries and Oceans Canada in their SCUBA population surveys in Western 

Canada. A description of dredge surveys and fixed camera frame surveys are in the following section. 

Trials run as part of the NPA URCHIN project and with the aim to develop cheap, effective and reliable 

methods of stock monitoring suitable for the environmental conditions found in the NPA are described 

in this report. These include Aerial, Dredge, ROV, Fixed Camera and Trapping surveys. The various 

techniques are used for either, surveying new fishing areas, or for scientific monitoring surveys and 

the advantages and disadvantages of each technique are discussed. 

Finally, we makes recommendations for the most suitable methods for each of the participating NPA 

countries (Norway, Iceland, Ireland and Greenland). 
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2  Introduction 

2.1  URCHIN project (Utilisation of the Arctic Sea Urchin Resource) 

The URCHIN project aims to utilise the sea urchin resource present in the northern arctic regions. The 

challenges of fishing, sustainable and responsible harvesting of stocks, legislation and supply chains 

for sea urchin products from isolated and environmentally harsh and challenging areas in the Northern 

and Arctic region will be addressed and overcome through innovation and national and transnational 

technology transfer. 

Currently there are small scale (<150 tonne p.a.) intermittent fisheries for sea urchins in the NPA. This 

is despite there being enormous sea urchin resources present in the area. A number of challenges have 

prevented the expansion of sea urchin fisheries in the NPA. These include environmental challenges 

to fishing, inadequate and inappropriate legislation and fisheries management and lack of technology 

and knowledge regarding sea ranching and roe enhancement of poor quality urchins. Research to 

overcome these challenges has been disparate and there has been no previous transfer of knowledge 

between the NPA partner countries.  

This project aims to gather the existing expertise from Norway, Iceland, Ireland and Greenland, 

together with knowledge from Canada to optimise the fishing of high value sea urchins in Northern 

and Arctic areas.  

2.2 Scope of this report 

As part of the larger Project aims this report, (Activity A4.1.1 of the URCHIN project) aims to provide 

details of suitable sea urchin stock assessment techniques for surveying new fishing areas as well as 

for scientific monitoring in the challenging environment of the NPA.  
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3 Stock monitoring techniques used in sea urchin fisheries  

3.1 Introduction 

Stock monitoring of sea urchin populations can be used for two main objectives: 

1. Surveying for new fishing sites. 

2. Scientific monitoring of sea urchin populations within a given area to monitor population levels 

and changes in these levels over time.  

There is little information in the literature regarding surveying for new fishing areas with most 

commercial fishing companies having their own tried and tested methods. 

Traditionally, population monitoring can be achieved by collating catch and catch per unit effort (CPUE) 

data from a sea urchin fishery. This is used to effectively monitor and set quotas in a number of 

countries around the world (e.g. Canada and New Zealand) (Miller and Abraham, 2011) that have long 

running, established and well-managed sea urchin fisheries. In the NPA countries participating in the 

URCHIN project, only Iceland and Ireland have catch data from sea urchin fisheries. However, in Ireland 

the current catches are only a fraction of what they were during the peak of the fishery (see Internal 

Nofima Report: Report 15/2016, Published March 2016, Sea Urchin Fishing techniques Report) and 

fisheries catch data is no longer sufficient to use for population monitoring. It is assumed that most of 

the coastal population of sea urchins in Ireland were effectively removed during the period. In Iceland, 

the current catch comes entirely from one fisher harvesting in one relatively small area (see Internal 

Nofima Report: Report 15/2016, Published March 2016, Sea Urchin Fishing techniques Report). 

Although catch data can be used for monitoring the population over time in this particular area, it 

delivers little information on the state of the sea urchin population around the entire coast of Iceland.  

This report provides techniques for enabling fishers and researchers in the NPA to be able to carry out 

surveys of sea urchin populations (for finding new fishing areas or as part of a scientific study) as and 

when required in the harsh environmental conditions experienced in the area. The report does not 

describe methods of fisheries stock assessment from catch data, nor how to approach stock 

monitoring using the data provided by surveys. It does introduce this topic based on the experience of 

the Fisheries and Oceans Canada Department. This is a complex area of research, normally undertaken 

by Fisheries Research Institutes in the country where the surveys take place, and as part of Fisheries 

Management Policies. 

3.2 Traditional large scale survey techniques 

Techniques used for broad scale assessment over large areas (for the purposes of this report a small 

area is considered to be greater than 1km2) include the following: 

 SCUBA surveys 

This is the traditional method of collecting information on sea urchin populations in a number of 

countries around the world. There are multiple examples of environmental studies that have used 

these techniques to monitor sea urchin populations, including ecological studies of multiple species 
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(e.g. the interaction between sea urchins and macro-algae) as well as looking directly at numbers 

(density) and size of sea urchin populations. The techniques normally involve the use of SCUBA divers 

undertaking transect dives where random quadrats are laid dowjan and the number and size of urchins 

within the quadrat are measured (Figure 1). Alternatively the divers lay down a transect line and count 

the density of urchins occurring in a set space either side of the transect line. Both techniques require 

teams of qualified and preferably experienced divers that are familiar with scientific diving. As has 

been mentioned a number of times the use of divers in the NPA area is both expensive and logistically 

difficult at different times of the year due to environmental conditions. Subsequently, there have been 

limited dive surveys undertaken in Norway, Ireland and Iceland and none in Greenland.  

 

Figure 1 A typical diver quadrat used to sample bottom invertebrates such as sea urchins. 

 Green Sea Urchin stock monitoring methods in the Pacific Region of Canada 

The following is a brief description of the SCUBA survey techniques employed to monitor sea urchin 
populations in the Pacific region of Canada (written and provided by Janet Lochead, Fisheries and 
Oceans Canada). 

Green Sea Urchin stocks in British Columbia, Canada, are monitored using industry-funded SCUBA dive 

surveys at index sites. The index sites are chosen through consultation with the commercial fishing 

industry, which identified fishing ‘hot spots’. The index sites also include control sites in areas closed 

to the commercial fishery. The objectives of the surveys are to study the natural fluctuations, as well 

as the effects of commercial fishing, on Green Sea Urchin densities and size.  

At each index site, the same 10 – 20 transects are surveyed either annually or biennially.  The transects 

run perpendicular to the shoreline and/or depth contours, from deep to shallow, from 10 m below 

Chart Datum to 0 m below Chart Datum.  Each transect line varies in length, depending on the slope 

of the bottom.  Tide tables are used to establish tide height, stage and range, before each dive to 

calculate the starting and approximate finishing depth. This ensures that the same area of the seafloor 

is surveyed at each sampling visit.  

The divers count and measure urchins occurring within a one square meter quadrat that is flipped over 

the substrate for the length of each transect, following either a lead-line or compass bearing. The 
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surveying scheme depends on average transect length. For transects with average lengths of 0 – 20 

metres, the surveying scheme is MEASURE – SKIP – COUNT – SKIP (M S C S). For transects with average 

lengths of 21 – 100 metres, the surveying scheme is MEASURE – SKIP – COUNT – SKIP – COUNT – SKIP 

(M S C S C S). For transects with average lengths over 100 metres, the surveying scheme is MEASURE 

– SKIP – COUNT - SKIP – COUNT – SKIP – COUNT – SKIP – COUNT – SKIP (M S C S C S C S C S). In a 

MEASURE quadrat, the divers record quadrat number, depth, time, substrate and habitat (algae), and 

measure every green urchin’s test diameter. In a SKIP quadrat, divers do nothing and they skip this 

quadrat. In a COUNT quadrat, the divers record quadrat number, depth, time, substrate and habitat 

(algae), and count all green urchins. Substrate is recorded as the three most prominent substrate 

types, in order of highest to lowest prominence. Percent cover for each substrate type is also recorded. 

Species and percent cover of algae are recorded under the following categories: canopy (over 2m), 

understory (20 cm to 2m), turf (5 – 20 cm), encrusting and drift.  

A computer program, called “The Green Urchin Analysis Program (GUAP)” was developed by Fisheries 

and Oceans Canada in 2013 to estimate mean density of Green Sea Urchins from the survey data. 

Details of the program and its calculations are described in Lochead et al. (2015). The analysis is based 

on the assumption of a continuous distribution of urchins between surveyed quadrats along the 

transect lines. The program conducts interpolation to fill in data gaps resulting from quadrat 

subsampling and implements an allometric relationship to convert test diameters to weight (for years 

when supporting length-weight data were not collected, i.e., 2012 onwards). 

Within a transect, GUAP uses linear interpolation to estimate the number of urchins in the uncounted 

quadrats (skip quadrats) based on the number of urchins in the two closest counted and/or measured 

quadrats. Then, for each measured quadrat, the probability of an urchin being legal-size (≥55 mm) is 

generated from the observed size-frequencies and according to the beta distribution and. The 

probability that an unmeasured urchin is either legal ( 55 mm) or sublegal (<55 mm) is called a size-

class probability. Linear interpolation is used again to generate size-class probabilities for quadrats 

without measured urchins (count quadrats and skip quadrats) based on the size-class probabilities 

from the two closest measured quadrats. The two closest measured quadrats refer to the measured 

quadrat that precedes and follows the skip or count quadrat in question. If the skip or count quadrat 

is towards the end of a transect and there is no following measured quadrat, then size-class probability 

is derived through extrapolation from the preceding measured quadrat only. 

For the calculation of biomass densities (g/m2), the sampling unit is a transect. GUAP incorporates 

variability among transects through bootstrapping. Transects are re-sampled with replacement and 

each time a transect is re-sampled, the size-class probabilities of the unmeasured urchins are 

regenerated as described above. For each re-sample, the ratio-estimator is used to calculate the 

density for legal and sublegal size-classes. The re-sampling process is repeated and 1000 estimates of 

density are generated. The frequency of these estimates is used as a proxy for the distribution of 

density by size-class. The calculation of confidence bounds is further refined using Bias-corrected 

accelerated percentile intervals (Efron and Tibshirani 1993). 

The biomass densities and standard errors from the survey data, along with CPUE from the commercial 

fishery, are as used as inputs to a Bayesian biomass dynamic model which produces maximum 

sustainable yield (MSY) probability distributions for each region (DFO 2014, DFO 2016). The MSY 

probability distributions form the basis of the science advice that is provided to Fisheries Managers, 

who chose the level of risk and the quotas associated with them. 
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In addition to the above, Appendix 1 contain protocols from Fisheries and Oceans Canada for 

measuring benthic marine sponges and 2) analysing still images from fixed camera surveys. 

 Dredge survey (New fishing areas and Scientific) 

Dredge surveys are also relatively uncommon but have been trialed in Iceland as part of the URCHIN 

Project. The results of these trials are given in Section 4 below. 

 Drop camera on a fixed frame 

This is a technique that has been used for a number of benthic deep water species (eg Nephrops Spp.) 

but it has also recently been used in preliminary studies for benthic invertebrate species such as sea 

urchins in Canada (Janet Lochead, Fisheries and Oceans Canada, pers com.). The trials using a drop 

camera and fixed frame to measure sea urchin abundance undertaken in Norway as part of the NPA 

URCHIN Project are discussed further in Section 4. 

Appendix 2 contain protocols from Fisheries and Oceans Canada for analyzing still images from fixed 

camera surveys. 

3.3 Traditional small scale survey techniques 

Techniques used for assessment of urchin stocks in relatively small areas (for the purposes of this 

report a small area is considered to be less than 1km2) include the following. 

 SCUBA survey  

The techniques here are the same as used for large-scale surveys in 3.2.1., however, there will be less 

transects, or quadrats since the area is much smaller.  

 Snorkel and surface periscope survey  

This is a relatively common method used by sea urchin fishers when surveying a new area for fishing. 

It consists of swimming over areas, or passing over them with a small boat and an underwater viewing 

periscope, or bathyscope, to look for new sea urchin populations but is not used for scientific 

monitoring as there is no way to accurately count or estimate urchin size from this technique. 

However, with sufficient experience it can be a very useful way of assessing urchin presence/absence 

and abundance on a small scale (R. Sloan, Arctic Caviar AS, Pers comm.). 
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4 Novel survey techniques being used and developed in the NPA 

4.1 Aerial survey large scale (>1km2) (Used to establish new fishing areas) 

This relatively new method of surveying is not described in the literature but it has been trailed in 

Norway as part of the URCHIN Project. The trials have involved the use of a fixed wing aircraft (a 

helicopter would also be ideal for this type of survey) and were conducted in collaboration between 

Nofima and Arctic Caviar AS. The following is a brief description of the aerial survey employed to search 

for new fishing areas in the Vestfjord area in north Norway (provided by Roderick Sloane, Arctic Caviar 

AS). 

 Aerial survey report for new fishing areas 

The aim of the survey was to use light aircraft to map kelp beds - the theory being that big kelp beds 

equates to no sea urchins, whilst barren rocks surrounded by kelp beds mean it is likely that there will 

be sea urchins in this area. 

Tuesday 23rd Feb 2016 

Flight information: 

Weather conditions - fairly good visibility with occasional cloud cover and snow flurries. 

Sea conditions – 10m/s wind from the North. 

A light fixed wing aircraft was used and the flight lasted for 3 hours. Taking off from Bodø we travelled 
across Vestfjord and then began mapping the northern side of the fjord. The return journey was spent 
looking at the south side of the fjord (see map in Figure 2). The whole route was tracked using a 
handheld GPS, which was used to mark waypoints of particular interest. Additionally, cameras were 
used to capture aerial images of all potential sea urchin sites.  

Beneficial aspects of survey technique: 

1) A large area was covered in the allotted time.  
2) Huge economic saving, primarily in the time required to survey using traditional methods. 
3) Birds eye view offered unique insight into surrounding area (e.g. are there any farms or 

industries nearby, are their mountains that will block sun for macro-algae growth). 
4) Excellent view of the geological formation of the rocks and the type of rock present in each 

reef system. 

Negative aspects of survey technique: 

1) This technique is obviously extremely weather dependent.  
2) You need an airport close to the survey sites. 
3) Need a skilled pilot (can’t do it yourself). 
4) Can’t stop when you want to / conduct counts and a more detailed site investigation. A 

helicopter would possibly be a better option than a fixed-wing aircraft. 
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Figure 2 The location of the survey site in Norway (left) and the route taken (solid blue line) in the Vestfjord 
area (right) during the aerial survey.  

General comments: 

 From the air it was possible to view extensive kelp beds at certain sites that we could 
immediately write off as having no potential with regards to future surveying and/or fishing.  

 Couldn’t actually see any sea urchins from above, yet provided invaluable knowledge of 
potential sites, and the sheer amount of area covered would take weeks using the traditional 
survey method utilizing a boat. With this relatively short survey (3 hours) it was possible to 
identify a handful of key sites that require closer inspection with a boat. 

The next phase is to get a diver in the water and have a look at the sites identified as having the most 

potential. This will give us a deeper insight as only a certain amount of the reef can be viewed from 

the boat, where as a diver can swim around the entire section. 

Thursday 10th Mar 2016 

 With good boating conditions available, we headed to North Lofoten to implement one of the 

traditional survey methods used by Arctic Caviar AS, using an underwater viewing periscope. We 

focused on one of the target areas and slowly made our way south using the on-board GPS of the boat 

to follow the route the aircraft had taken and locate shallow reefs, again using ‘Way Points’ to mark 

locations that could hold potential for the future. 

After spending 7 hours at sea, several prospective sites had been examined. Some of these contained 

sufficient quantities of harvestable, commercial size sea urchins. Other areas contained large 

populations of small non-commercial size sea urchins. Due to weather conditions certain exposed 

south facing reefs could not be examined. These areas are known to have the best commercial fishing 

zones from past survey and fishing experience. 
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Conclusion: 

The initial survey with the aircraft gave a good, broad overview that significantly reduced the amount 

of time (and cost) involved in identifying sites with commercial potential for harvesting sea urchins. 

However, this technique still requires the boat and a diver in the water to quantify definitive results.  

 

Figure 3 From left to right: Roderick Sloane (Arctic Caviar AS) planning with pilot; the fixed-wing plane used 
in the survey; aerial shots of the reefs and surrounding reef structure. 

4.2 Aerial survey small scale (<1km2) (Used to establish new fishing areas) 

Following on from the large scale aerial survey Nofima has investigated the use of small, relatively 

cheap drones to survey smaller, more specific areas. This method of surveying has not been previously 

described in any literature. The following is a short description on the use of drones as a survey tool.  

 Drone aerial survey in Tromsø, Norway 

A preliminary study in Tromsø investigated whether or not the information gathered from drone flights 

is useful for finding new fishing sites and areas. A drone (Phantom 3 Advanced model, 1280g, operates 

in 0 - 40o, maximum flight time 23 minutes, approximate cost 11,000NOK) (Figure 4) was used to make 

both shore based and boat based flights to survey a relatively small area (approximately 0.5km2). 

In the first trial the drone was launched from shore and an aerial video survey of approximately 500m 

of coastline was made. For the second trial the drone was launched from a 5m boat and an area that 

had been previously surveyed using fixed frame camera and divers was surveyed from the air (Figure 

4). 

The drone flights produced video of excellent quality that clarified the reef structure and provided 

excellent information for locating possible fishing locations within the area. The second day of testing 

which was conducted from a relatively small boat proved that the drone is easily launched and 

retrieved from a small moving platform and that it was a very effective technique for fast aerial surveys 

of a relatively small area. This technique could be used by fishers to rapidly identify parts of extended 

reef systems that are most likely to produce sea urchins. This would eliminate some of the need for 

extensive in water surveying and enable the fisher to go straight to the sites with the greatest potential. 

During the preliminary test the drone was flown at increasing heights and the resulting images were 

compared. It appeared that the higher the drone flew (maximum height tested was 70m) the better 

the reef structure was visible with lower heights not adding any clarity, or detail to the image. The 

relative visibility will likely be affected by the clarity of the water and at the time of the trial the summer 

algal blooms had already appeared in Tromsø. If the trial was repeated at times of high visibility and 

sunlight (spring) the results would be better. 
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The relatively cheap cost of modern drones and the ease that they can be deployed and flown means 

this is a very realistic tool for sea urchin fishers in remote areas where rapid surveying of a reef system 

is required. It is reliant on relatively calm weather so that visibility is good and so that the drone is not 

damaged or lost. 

A)  

   

Figure 4 The aerial surveys using the drone model ‘the Phantom 3 drone’ (top) and aerial shots taken from 
the drone at a height of approximately 40m showing reef structure along the shoreline (bottom). 

4.3 Dredge survey (Used to establish new fishing areas and possibly in scientific 
surveys) 

 Large area survey 

Surveys were conducted to assess the usable sea urchin biomass in southern Breidafjördur (south 

65°10N and East 22°40W) (see Figure 5A) at depths of 8-60m from 13th - 18th of September 2015 and 

11th-13th of April 2016. The surveys were conducted by a commercial sea urchin fishing vessel (Fjóla 

SH 7) (Figure 5B) using a commercial dredge measuring 250 cm in width and with 150 cm long bag 

(Figure 5C). The mesh size of the catch-bag on the dredge was 100mm. In order to determine the 

densities/abundances of urchins, each catch was weighed and the distance covered by the dredge was 

calculated. The total catch weight was divided by the size of the area covered in each tow to give 

biomass in kg/m2. Biomass estimates for any given area were calculated from the mean biomass in 

that area multiplied by the total size of the area. 

The density (ind./m2) was calculated by dividing the mean wet weight of the individuals in an area into 

the abundance (kg/m2) of the area. 
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A)  

B)  

C)  
 

Figure 5 A) A map of the fishing areas investigated in Breidafjördur, Iceland. The red and the green dots 
denote the stations surveyed in September 2015 and April 2016 respectively, the blue are photo 
stations from September 2015, B) The fishing vessel used in the survey, C) The sea urchin dredge 
used in the trials. 

During the surveys, sea urchins were found in all areas and at all stations sampled (91) (Figure 5A), 

regardless of depth (8-60 m) but in varying densities. The whole area investigated measured 9.7 km2 

and contained seven smaller harvesting areas. Five areas with urchin roe of good quality were 

observed, these were relatively small (0.3-1.4 km2). The estimated mean abundance varying between 

0.17 - 0.52 kg/m2 and the density from 2.0 - 8.5 ind./m2 which correlated with depth and bottom 

topography.  
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The standing stock for all areas combined was 3,395 tonnes. The average efficiency (23%) of the dredge 

was used when assessing the stock size. The two biggest areas observed, 2.7 and 3.4 km2 contained 

urchins of poor quality (<5 % gonad index) but in considerable abundance.  

The distribution of the green sea urchin in Breidifjördur is very patchy with the results showing seven 

small fishing areas, ranging in size from 0.3 - 3.4 km2, at 8-60m depth. Most of the tows (88 %) were 

made between 8-35 m depth. The green sea urchin is most common in the shallow subtidal zone at 

depths (less than 50m) but they have also been observed at depths as deep as 300m (Jensen 1974). 

The density generally decreases with depth to about 20-30m which in many areas corresponds to the 

deepest distribution of kelp (Himmelman 1986). In the present study no bottom samples were taken 

but it was obvious that the substrata differed significantly between areas. The most common bottom 

type was sand and gravel although rocky substrata was also observed. The green sea urchin generally 

occurs on rocky substrata but is also found on sand and gravel botttoms (Filbee-Dexter and Scheibling 

2012). Upper depth limits vary with season and wave action that can dislodge the urchins or limit their 

ability to graze on macroalgae. On a sedimentary seafloor the urchins rely on drift algae and are more 

sparsely distributed (Filbee-Dexter and Scheibling 2012).  

The bottom type in Area I and II was gravel at mean depth of 35m and the biomass or density at both 

areas was rather low (0.08kg/m2 or 1ind/m2). Kelp was observed at the site not kelp beds as these 

occur at a maximum depth of 30m depth (Himmelan 1986). The maximum biomass observed was in 

area III (0.12 kg/m2 or 1.6 ind/m2) at lower depth (10m) where there was a gravel seafloor and kelp 

beds. In area IV the depth was 10m, the density was similar as in the previously mentioned site but 

here the urchins were of poor quality and small size. Area VI had the greatest depth (50m) and a muddy 

bottom with the lowest biomass (0.04kg m-2, 0.5ind. m-2). The biggest urchins with the largest roe 

(gonad index) were observed at area VII at 20 m depth, with a gravel and rocky seafloor and kelp was 

also observed at the site. 

 Small area survey 

A preliminary small-scale trial was run by Nofima to test the efficacy of a small dredge (see Figure 6 for 

details of dredge design) at predicting sea urchin biomass in a small survey area. The chosen area had 

been surveyed previously and had a flat area of seafloor (approximately 500m x 50m) at depths of 2-

7m. Three dredge transects were made in the area and the results are compared with the results of 

two previous dive surveys conducted in the same area and at the same depths (Table 1). 

The results show that the estimates for the abundance of urchins was much smaller from the dredge 

results than from the dive quadrat results. This indicates that the dredge used in the trial is not 

effectively collecting all the urchins in the sampling area (the area it covers during a single tow). Not 

surprisingly, the average size in the dredge is slightly higher than in the dive survey and this is likely 

due to the dredge not picking up very small urchins. If a dredge is to be used for biomass or size 

estimates of sea urchin populations it would need to be more efficient than the one used in this trial 

and the efficacy of the dredge would need to be calibrated against dive surveys in an area to be sure 

the results are accurate. In conclusion, the authors believe there is limited capacity to use mini-dredges 

as a survey tool but if a more efficient dredge can be used the efficiency of this technique would 

improve.  
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Figure 6 The mini-dredge used in the Nofima trial, left and the dredge being pulled onboard (right). 

Table 1 The comparative results of three transects using the mini dredge and two previous dive surveys 
measuring the abundance and size of urchins present in the survey area. 

Dredge Dive survey 

Dredge Depth 

(m) 

Urchins in 
dredge 

Length of 
tow 

(m) 

Square 
meters 
covered 

Average 
count / 

m2 

Average 
size TD 
(mm) 

Average 
count / 

m2 

Average 
size TD 
(mm) 

1 5 829 64.5 34.8 23.8 25.1 27.3 24.2 

2 3 298 66.9 36.1 8.2 21.3 38.2 23.4 

3 7.5 249 67.0 36.1 6.9 30.5   

Average 5.2 459 66.1 35.6 12.8 25.6 32.8 23.8 

4.4 ROV large and small scale (Used to establish new fishing areas and possibly in 
scientific surveys) 

This is also a relatively new method of surveying has not been described in the literature but 
preliminary trails have been undertaken in Norway both prior to and as part of the URCHIN Project.  

 Remote Operated Vehicles, ROV (large and small scale) 

Nofima in Norway have previously undertaken a trial using a larger, modified ROV  (Figure 7) to fish 

for sea urchins (see Nofima internal report number 2012, Published March 2012. Test of ROV-based 

harvesting methods for sea urchins and scallops Part one: Preliminary report on Sea Urchin collection 

trial). The trial focused on the collection of urchins but one of the clear outcomes was that the 

effectiveness of the large ROV was reliant on the abundance of sea urchins and the type of bottom 

substrate. The first 2.5 days of the ROV fishing trial were spent searching for suitable fishing areas and 

the large ROV was not an effective means of rapidly surveying new areas. It was difficult to launch and 

retrieve and required the boat to be anchored at all times. It also required a relatively large boat to be 

launched from and required a powerful and consistent power source. A smaller ROV that was easier 

to launch and that could be operated from a smaller boat would have been ideal for the start of this 

trial to rapidly survey large areas and identify those that were suitable for fishing using the larger ROV. 
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Figure 7 The modified ROV used to fish for sea urchins in a previous Nofima trial and the launching and 
retrieving process. 

Nofima have since tested two types of mini ROV for rapid surveying of underwater sea urchin 

populations and seafloor habitats, urchin presence/absence and as an initial survey of urchin 

abundance. This technique is particularly useful when divers are not available, when conditions may 

not suit divers, when urchin populations are deeper than safe dive limits and when rapid, repetitive 

surveys are required. The mini ROV comes in a range of models varying in size, ability and price. Two 

examples are: 1) The battery operated Deep Trekker (Figure 8a) with a total battery life of 

approximately 3hrs and a 70m umbilical line. The purchase costs of this model is approximately 

75,000NOK. Alternatively, the slightly larger, more powerful model SeaBotix LBV300-6 (Figure 8b) is 

easier to manoeuvre and can handle higher currents and has a 300m umbilical line. It requires a 

transportable generator but these are relatively light and inexpensive and can be operated from a 

small boat. The purchase costs of type of mini ROV is approximately 250,000NOK. 

 

  

Figure 8 The mini ROVs tested by Nofima in Norway for rapid initial site surveying for urchin abundance; 
Left) the deep trekker, Right) the SeaBotix LBV300-6 mini ROV. 
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The min ROV’s would be very effective for rapid surveying of new fishing areas but would have very 

limited use as a means of scientific surveying for the following reasons: 

 They are very difficult to operate in high current areas, which is where urchins are most likely 

to be found (Janet Lochead, Fisheries and Oceans Canada, Pers Comm.). 

 It is very difficult to estimate the field of view, which you need in order to calculate area swept. 

It is most difficult to estimate field of view on complex substrates, and easier on flat, uniform 

substrates (Janet Lochead, Fisheries and Oceans Canada, Pers Comm.). 

 The post-processing of ROV video is very time consuming. For Rockfish video review, for 

example, which included reviewing the video for all fish observations as well as habitat and 

field of view, 5 hours of processing were required for every 1 hour of video, but depending on 

the fish abundance, it could be 4:1 (Janet Lochead, Fisheries and Oceans Canada, Pers Comm.). 

4.5 Fixed camera quadrats using a drop frame 

 Methodology for urchin stock assessment with drop-cams used by Nofima 

Equipment required: 

 A frame constructed from 8mm stainless steel bar with a bottom area of 1m2 square and 1m 
height (Figure 9).  

 A GoPro camera, mounted in the top of the frame, faced down so that it could film the entire 
1m2 frame below.  

 A rope marked every half meter was attached to the top of the frame.  

 A handheld GPS-unit was set to store positions in its track log every 5 seconds.  

 An accurate clock for the boat skipper.  

 The camera clock and the skipper’s clock was synchronised to match the GPS-clock. 
 

 
 

Figure 9 The steel frame used for fixed frame camera surveys in Norway. 

Method: 

The GoPro cameras time-lapse function was selected so that the camera would take one picture every 

set period until it was shut down or ran out of power. For these trials we set it to take one picture 

every 5 seconds. The setup was operated by two people, one driving the boat and taking notes, the 

other manually lowering the frame to the sea-floor for each quadrat sample. Typically, the boat was 
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driven close to the shore and the frame dropped at 1 meter depth. The person lowering the frame 

would transfer the actual depth of the frame to the driver taking notes. The frame was left stationary 

on the bottom for at least 5 seconds to make sure the camera took at least one image. The driver 

would take a note of the depth and the exact time (HH:MM:SS). The boat would be driven slowly 

backwards at a 90 degree angle to the shore line and the camera dropped again at different depths 

until a straight transect from 1 to 10 meters was obtained (approximately 6 transects on each site to 

be evaluated). 

Post processing of data and counting urchins 

The images were imported to a computer and batch rename them to a new filename based on their 

timestamp: DDMMYY_HHMMSS.jpg using Adobe Bridge. The list of image files was then checked and 

all images that were not taken when the pyramid was stationary at the sea floor were deleted.  The 

remaining images would be renamed again as such: TransX_Ym_DDMMYYYY_HHMMSS.jpg based on 

the boat skipper’s notes and the image files timestamps. The GPS log was then edited the same way, 

deleting all entries that didn´t match an image within 5-10 seconds. 

Each image was then opened in an image editing program (Adobe Photoshop) and a grid overlay with 

10 centimeters was applied for easier counting (Figure 10). We would count all visible urchins manually 

by clicking them with the paint tool, doing one box of the grid at the time. 

 

 

Figure 10 The image processing used on the images after the fixed frame camera survey. 

Janet Lochead (Fisheries and Oceans Canada) reported that Fisheries and Oceans Canada have 

developed publically available software for imaging analysis. There is a very simple analysis program, 

called ‘AVLOG’, for green urchin drop camera photos. There is a more complicated program called 

‘Video Miner’, which is for multiple species and habitat variables. Finally, there is a third called ‘ImageJ’ 
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which can record measurements and well as counts and would be very useful for urchin assessments 

(see the Fisheries and Oceans Canada website for further details:  http://www.dfo-mpo.gc.ca). Galway 

Marine Institute of Technology also use a program called ‘Pro plus’ which can record measurements 

and counts and would also be very usedful for urchin image analysis. This program also allows images 

that have been squeezed due to the curvature of the lens to be squared for easier viewing. 

 Comparative study between fixed frame camera and dive survey (Norwegian trials) 

A survey conducted in Tromsø, Norway tested the efficacy of fixed camera quadrats in comparison 

with the more traditional technique of using divers to count and measure urchins.  

A series of three transects were made in an area that has been extensively surveyed (including mini 

dredge and trap surveying). It has a rocky shoreline down to approximately 1-2m depth and then a flat 

shelving sea-floor which consists of shell and gravel. Three fixed frame camera quadrats were 

measured from each transect as described in the methodology in section 4.5.1. After the photo was 

taken and before the frame was shifted, all the urchins in the quadrat were collected by a diver and 

transferred to the boat for counting and measuring. A comparison of the counts was then made 

between the two techniques. 

The results showed that on average the urchin counts taken using the fixed frame camera technique 

were 83% lower than taken from the same quadrat by diver collection. However, there was a high 

percentage of very small urchins in the quadrats (average test diameter 23.4mm and only 5 % of the 

catch were greater than 40mm test diameter) and these urchins would have been difficult to see in 

the images taken using the fixed frame camera. The authors intend to run a more comprehensive test 

of the efficacy of this technique to quantify the presence of market size urchins, and to test the efficacy 

on different substrate types. They believe that if the seafloor is relatively flat and the urchins present 

are primarily adult urchins the counts would be extremely accurate.  

 Comparative study between fixed frame camera and dredge survey (Icelandic trials) 

As part of the URCHIN project, surveys using bottom photographs were completed between November 

2015 and April 2016. These included photographing, counting and identifying all species present in the 

photos. The number of sea urchins/m2 of bottom was estimated and compared to abundance 

estimated from a survey where swept area method (dredging) was used to assess the abundance 

(Figure 11). 

The efficiency of the dredge ranged from 10 to 33% depending on bottom type and currents. When 

fishing on hard seafloor, and when there were strong currents present the dredge efficiency decreased 

considerably. 
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Figure 11 Bottom photographs from different types of seabed in Breidifjördur. To assess the efficiency of the 
sea urchin dredge, number of sea urchins observed from the photos was compared to number sea 
urchin fished at the same site. 

4.6 Trapping 

 Surveying for fishing suitable sites using trapping  

Trapping techniques for harvesting sea urchins have been developed in Norway over the past 2-3 

years. The Nofima Internal Report (Report 38 B/2014, 2014, Alternative low cost methods of fishing 

sea urchins) gives a detailed account of the optimal type of traps, the baits and the soak times from 

these trails. As part of the URCHIN Project a further trial was undertaken using the traps described in 

the above report (Figure 12) to test for variation in catch rates and urchin size at different sites using 

the same trapping protocols. Traps were set at six sites (Figure 13a and 13b) with varying 

environmental conditions.  

Site 1: Fokevik 

The traps were set near the boulder/sand-line. Approximately 5m depth. Gradually sloping downwards 

with boulders to 5m and beyond flat sand.  

Site 2: Småseines 

The traps were set around the 5m transition. Large boulders in depths less than 5m, smaller rock and 

coarse sand at depths deeper than 5m. 

Site 3: Sperkelnes 

5 meters or deeper, rock with some sand in between. 
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Site 4: Myra 

Traps set between 2 and 8m. Hard rock with kelp in the shallow area and, in deeper area smaller rock 

with sand in between (No pictures due to very heavy current). 

Site 5: tunnel 

Traps set on both solid rock and a little bit deeper where it goes from solid rock to small boulders with 

sand and coral in between. 

Site 6: Nordhellenes 

Traps set between 3 and 8m. Solid rock with patches of sand and boulders.  

 

    
 

Figure 12 The round collapsible traps designed and tested by Nofima in Norway; sitting on the bottom (left) 
and being pulled into the boat (right). 

 

Figure 13 a)   The location of the six sites in Kvalsund, Tromsø, used in the trapping experiment. 
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Figure 13b  The bottom substrate of the six sites in Kvalsund, Tromsø, used in the trapping experiment (Note 
site 4 is missing due to extremely high currents at the time of sampling). 

The results from the survey are listed in Table 2 and clearly show that trapping could be a viable option 

for distinguishing sites that have sufficient urchin abundance and urchins of a suitable size for fishing 

from those that do not. Following on from these trials the technique was also tested on a semi 

commercial scale (see following section 4.6.2.). 

Table 2 The number of traps, average soak time, total catch, average test diameter and total number of 
urchins greater than 40mm test diameter collected from the 6 sites. 

Site 1 2 3 4 5 6 

Number of traps 16 14 16 15 16 16 

Average of Soak time (days) 8.8 8.4 8.8 8.9 8.8 8.8 

Total catch (#) 455 503 648 1973 1015 960 

Average diameter (mm) 28.0 29.6 32.9 26.6 33.1 32.6 

Total # >40mm 59 126 187 173 358 248 

 Commercial trapping trial to survey for urchin abundance and size 

In addition to the test survey in 4.6.1. a series preliminary commercial trapping trials were used as a 

means of surveying for new urchin fishing sites in Lyngen, north of Tromsø in Norway. The trials utilised 

the round collapsible traps developed by Nofima (see Figure 12) and were run in conjunction with the 

mussel farmer, Arne Samuelsen from Lynsskjellan AS, situated at Rotsund, Lyngen. Each trial involved 
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setting a minimum of three lines of between 4-10 traps (baited with a variety of algae and fish baits) 

in areas around Uløya (See Figure 14). The traps were set for periods between 6-9 days and the catch 

rates are shown in Table 3.  

The efficacy of the traps and baits used in the trials has been proven in previous studies (See Internal 

Nofima Report: Report 38 B/2014, 2014, Alternative low cost methods of fishing sea urchins) and so 

the catch rates were considered a suitable indication of urchin presence/absence of urchins as well as 

the urchin size in the area. The results clearly show that trapping is an effective method of 

distinguishing between suitable sites for urchin fishing. It gives both an indication of the density of 

urchins present as well as their size. The traps can be set easily and can cover a wide area. Nofima 

would recommend this is a suitable method of surveying new areas for sea urchin fishing, particularly 

where diving is difficult, or expensive. 

 

Figure 14  The areas where the trap lines were set around Uløya in Lyngen. 
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Table 3 The number of traps, trap lines, dates traps went into and out of the water and the catch numbers for the commercial trapping trials conducted in either the 
Uløya or Rotsund area in Lyngen. 

 Set 1 

(Uløya) 

 

(Uløya) 

 

(Uløya) 

Set 2 

(Uløya) 

 

(Uløya) 

 

(Uløya) 

Set 3 

(Uløya) 

 

(Uløya) 

 

(Uløya) 

 

(Uløya) 

 

(Rotsund) 

 

(Rotsund) 

Set 4 

(Rotsund) 

 

(Rotsund) 

 

(Rotsund) 

 

(Rotsund) 

Trap No. Trap 
line 1 

Trap 
line 2 

Trap 
line 3 

Trap 
line 1 

Trap 
line 2 

Trap 
line 3 

Trap 
line 1 

Trap 
line 2 

Trap 
line 3 

Trap 
line 4 

Trap line 5 Trap line 6 Trap line 1 Trap line 2 Trap line 3 Trap line 4 

Number 
of traps 

10 10 10 10 10 10 5 5 5 5 5 5 6 4 9 9 

Date In 22 Apr 22 Apr 22 Apr 29 Apr 29 Apr 29 Apr 6 May 6 May 6 May 6 May 6 May 6 May 18 May 18 May 18 May 18 May 

Date Out 29 Apr 29 Apr 29 Apr 6 May 6 May 6 May 15 May 15 May 15 May 15 May 15 May 15 May 26 May 26 May 26 May 26 May 

Number 
of days 

7 7 7 7 7 7 9 9 9 6 6 6 8 8 8 8 

Catch 
urchins 

< 40mm 
TD 

0 0 46 0 0 10 6 4 6 14 79 13 105 113 44 69 

Catch 
urchins 

> 40mm 
TD 

0 0 80 0 0 16 5 5 6 15 73 6 63 82 35 50 
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5 Summary and Recommendations 

5.1 Summary  

This report describes a number of different techniques for surveying new fishing areas and/or 

surveying for scientific monitoring of urchin populations. The best method for individual companies, 

Research Institutes in different countries will depend on a number of factors. The following is a list of 

recommendations for participating countries in the NPA URCHIN project. The relative 

advantages/disadvantages of each technique are summarised here. 

 SCUBA 

Advantages: This is the most commonly used technique and provides very accurate measures 

of urchin size and numbers. This method also has protocols established for analyzing the 

resulting data and calculating population biomass in any given area.  

Disadvantages: In a number of countries, particularly in the NPA diving as an expensive and 

unrealistic method of surveying. In addition to the high cost the environmental conditions in 

the NPA are often not suited to dive operations. SCUBA diving is restricted to relatively shallow 

depths unless specialised divers are utilized. 

 Dredge 

Advantage: This a good method of surveying large areas quickly. Particularly if there are 

already dredge operations in place in an area, using a dredge design that is known to be 

effective. 

Disadvantage: A number of countries within the NPA do not allow dredges to be used for 

environmental reasons. It is essential that the efficiency of the dredge be calibrated (validated 

against a known survey technique) prior to using any data from dredge catch surveys. The 

small-scale dredge used in Norway was not effective at catching the small urchins present at 

the site.  

 Aerial survey 

Advantage: This is a very fast and effective means of covering very large areas for a general 

overview of reef structure and potential new fishing sites. Small drones appear to provide 

excellent images of smaller areas. 

Disadvantage: This technique is very weather dependent and does not give any indication of 

urchin presence/absence or abundance. 

 ROV survey 

Advantage: The ROV surveys provide a good, rapid in-water method of surveying new areas 

for presence/absence of urchins without the need to use divers. Mini ROV’s can be used at 

depths not suitable for divers and can make repeated short exploratory surveys that a diver 

would not be able to do.
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Disadvantage: It is difficult to accurately map where you have surveyed underwater without 

having expensive sonar equipment. Strong currents also make this method impractical in some 

areas. Large ROV’s (larger than a mini ROV) are too cumbersome for this task. 

 Trap survey 

Advantage: Traps are cheap and easy to set for fishers that are already established. They give 

a good reflection of the presence/absence and available biomass and size of urchins in an area. 

Disadvantage: The catch rates in traps can be influenced by factors other than urchin 

presence/absence and so the surveys should be treated with caution.  

 Fixed frame camera survey 

Advantage: This is a very cheap alternative to dive surveys and give reasonably good catch 

(and possibly size) estimates depending on the type of substrate and the size of the urchins. 

Disadvantage: It can be difficult to see small urchins and urchins in very complex substrate 

(e.g. boulders). 

5.2 Recommendations 

The following is a suggested list of possible survey techniques for each of the participating NPA 

countries. The techniques in bold are the most likely candidates listed. 

 Norway 

Surveying for new fishing areas: SCUBA, Aerial, ROV, Trap, Fixed frame camera. 

Scientific surveying: SCUBA, Trap, Fixed frame camera. 

 Iceland 

Surveying for new fishing areas: SCUBA, Dredge, Aerial, ROV, Trap, Fixed frame camera. 

Scientific surveying: SCUBA, Dredge, Trap, Fixed frame camera. 

 Ireland 

Surveying for new fishing areas: SCUBA, Aerial, ROV, Trap, Fixed frame camera. 

Scientific surveying: SCUBA, Trap, Fixed frame camera. 

 Greenland 

Surveying for new fishing areas: SCUBA, Dredge, Aerial, ROV, Trap, Fixed frame camera. 

Scientific surveying: SCUBA, Dredge, Trap, Fixed frame camera. 

 



 

25 
 

6 References 

DFO 2014. Stock Status Update and Quota Options for the Green Sea Urchin (Strongylocentrotus 

droebachiensis) Fishery in British Columbia, 2013-2016. DFO Can. Sci. Advis. Sec. Sci. Resp. 

2014/052. 

DFO 2016. Stock Status Update and Harvest Options for the Green Sea Urchin (Strongylocentrotus 

droebachiensis) Fishery in British Columbia, 2016-2019. DFO Can. Sci. Advis. Sec. Sci. Resp. 

2016/031. 

Filbee-Dexter, K. and Scheibling, R.E., 2012.  Hurricane-mediated defoliation of kelp beds and ulsed 

delivery of kelp detritus to offshore sedimentary habitats. Mar. Ecol. Prog. Ser. 445: 51-64. 

Himmelman, J.H., 1986. Population biology of green sea urchins on rocky barrens. Marine Ecology 

Prog. Series, 33: 295-306. 

James, P., Noble, C., Siikavuopio, S., Sloan R., Hannon, C., Þórarinsdóttir, G., Ziemer, N., Lochead., 2016. 

Sea Urchin Fishing techniques Report (Activity A3.1.1 of the NPA URCHIN project). Internal 

Nofima Report 15/2016, pp. 21. 

Jensen, M., 1974. The Strongylocentoridae (Echinodiea) a morphologic and systematic study. Sarsia, 

113-148. 

Lochead, J., Hajas, W., and Leus, D. 2015. Calculation of mean abundance in the Red Urchin Analysis 

Program and Green Urchin Analysis Program. Can. Manuscr. Rep. Fish. Aquat. Sci. 3065: vi + 41 

p. 

Miller and Abraham, 2011. Characterisation of New Zealand kina fisheries. New Zealand Fisheries 

Assessment Report 2011/7, March 2011. 95pp. 

 

 

 
 



 

 
 

Appendix 1 
 
Sea Urchin surveying techniques 
(Activity A4.1.1 of the NPA URCHIN project) 

Activity 4.1 Activity title 
Measuring sea urchin 
stock biomass 

Start month 
04.2015 

End month 
07.2016 

Description: 
Develop a cheap, effective and reliable method of stock 
assessment suitable for the environmental conditions found in 
the NPA 

Deliverables: 
Report on a suitable sea urchin stock 
assessment technique 

4.1.1  Deliverable 

Methodology for 
stock assessment 

Target value 

Supply 
methodology to 
all participating 
NPA countries 

Delivery month  

06.2015 

 

Followed by the following Activity: 

(NOTE: the mini ROV trials will be replaced by drop camera trials following the results in the trials in 

Activity 4.1) 

Activity 4.3 Activity title 
Implement biomass 
assessment 
technique 

Start month 
09.2015 

End month  
09.2017 

Description:  
Trials will be conducted using dredging and a mini ROV techniques 
developed in Activity 4.1 to assess urchin stock size in 3 NPA 
countries.  
Greenland: July - August 2015:  mini-ROV biomass estimation in 
key areas of Greenland 
Iceland: September-October 2015: mini-ROV biomass estimation 
in key areas of Iceland and stock assessment by a dredge in 2 
different areas in September 2015 and September 2016. 
Norway: September-October 2015: mini-ROV and dredge biomass 
estimation in 2 sample areas between September 2015 and 
September 2017. 

Deliverables: 
Comparing techniques and assess 
stock size in a minimum of two areas 
in three NPA countries 

4.3.1  Deliverable 

Biomass assessment 
trial 

Target value 

Completed in two 
areas from three 
NPA countries 

Delivery month  

09.2017 

 
  



 

 
 

Appendix 2: Measuring Sponge Protocol  
  



Explanation of task 

We need to get an idea of sponge size on each of the glass sponge reefs in the Strait of Georgia. 

To do this, we have randomly selected 10 images taken on the reefs during our survey in 2013. 

You will measure the size of all of the sponges in those 10 images. If an image does not have any 

sponges you will include an 11
th

 image, if two images don’t have sponges you will review a 12
th

 

image, etc until you have measured sponges from 10 images. Some images will have more than 1 

sponge; you will measure all sponges in the image (up to 10). There were multiple transects per 

reef, and the images selected span those transects, this is intentional. You can measure the first 

10 images for a reef in any order you like, however, once you move on to extra images (i.e. the 

11
th

, 12
th

, etc) you must do them in the order provided. Below are step by step instructions. 

 

Measuring sponge protocol 

1. Open Image J 

2. Open the excel file named “Random_image_list.xlsx” 

3. Start with Reef 1 

a. The first ten images are sorted by transect number and then image number on the 

left of each sheet (Nanaimo and Parksville only have one transect so this was not 

done for them). 

 
i. The images you received from Anya are organized in folders that 

correspond to the transect number. For example the folder Dive 1 

corresponds to Transect 1. 

ii. The image number is found at the end of each image file name for 

example 120513_155212_1.jpg is image number 1 

4. Open the first image with Image J (File → Open or Control O) 



5. Record if sponges are present in the Excel file.

 
6. If sponges are not present move on to the next image.  

7. If sponges are present select the straight line tool. 

i. Draw a line between laser points. There are three laser points. You want to 

use the two that are in a vertical line. If they are all lined up, use the inner 

two.  

1. NOTE: there are images where the laser points are difficult to see, 

if you cannot easily see them zoom in and search the center of the 

image. If you still cannot find the laser points, make a note in the 

sponges present field and do not analyze the image further. 

 

  



8. Set the scale for the image.  

a. Go to Analyze → Set scale 

b. In the “Known distance” field put 10 

c. Change the “Unit of length” to cm 

d. Press ok  

 
9. Begin measuring sponges. 

a. If a sponge is partly in the image DO NOT measure it. 

b. For each sponge you will decide which geometric shape it most resembles (i.e a 

circle, square, triangle, etc). Below is a list of shapes and the measurements you 

should take for each one and the formula to calculate area. Remember, no shape is 

going to be perfect, do the best you can. Also, this list is not exhaustive.   



 

 
c. Record the area for each sponge in the image up to 10 sponges. If there are more 

than 10 sponges in the image do your best to capture the size range present in the 

image. In other words, measure the smallest and largest sponges then randomly 

select the other 8 sponges you will measure, being on the lookout for an 

unconscious bias towards the smaller or larger sponges.  

10. Repeat until you have measured sponges in 10 images for Reef 1. The maximum number 

of sponges you will measure for each reef is 100, the minimum is 10.  

11. Move on to Reef 2 and repeat steps 1-10 until all Reefs have had sponges in 10 images 

measured.  



 

 
 

Appendix 3: Protocol for analysing still images 



Protocol for analysing still images 

 

1. Record species present in every image 

a. Record “species” present in each image, their quantity, and your confidence in your ID in 

the still images database on the hard drive you received. You do not have to get to 

species, assign organisms to the lowest taxonomic level you feel comfortable. There are 

three Photo ID guides in the ID_Guides folder on the hard drive you received to aid with 

identification. If you need help, make a note of the image number and the approximate 

location of the organism and we can discuss the ID at a later time. 

b. If there are reef-building sponges in the image 

i. They should be entered in the database as Hexactinosida. 

ii. Record if you see any physical signs of damage for any sponge in the image. In 

the SpongeDamage column.  

iii. Do not attempt to count individuals, instead we will record the number of 

osculum visible in the image. For smaller sponges this may be done by easily 

counting. If the sponge is large enough that you feel you will lose count, then 

follow these instructions: 

1. If the toolbox is not on your screen press control B or go to 

Windows→toolbox. 

2. If the tool options dock is not on your screen go to Windows→ Dockable 

dialogues →tool options 

3. Place a black circle/oval over each osculum by using the ellipse select 

tool then filling in the selection using the bucket fill tool (shift B, Make 

sure to select “fill whole selection” in the “Affected Area” section of the 



tool options.). The placement of these does not need to be exact. It is 

important to ensure none of the circles touch. 

a. NOTE: it may be easier to add all the circles at once, then fill 

them in. To do this, once you have placed the first circle using 

the ellipse select tool hold down the shift key while placing the 

remaining circles. Once you are done you can switch to the 

bucket fill and it will fill all the circles at once.  

4. Select all the circles using the select by color tool (shift O). 

5. Press control I to invert the selection. 

6. Using the bucket fill tool color the background white.  

7. Export the image with the original file name_osculum. 

8. Open the image in ImageJ 

9. Go to Go to Image→Adjust→Color Threshold 

a. This should automatically select all the dots in the image. If it 

does not, Use the Wand (tracing) tool to select one filled shape. 

Press sample in the color threshold dialogue window. If all 

shapes do not automatically turn red adjust the hue, saturation, 

and brightness until all shapes red. 

10. Go to Analyze→Analyze Particles 

11. Press ok 

12. The count that shows in the result window is the number of osculum. 

Record this number in the database. 

2. Record dominant substrate within a 10 cm grid 

a. Create a new  .csv file for every image,  

i. Use the following naming convention YXXTAAIZZZ where XX= the last two 

digits of the year, AA is the two digit form of the transect number (i.e. transect 2 

would be recorded as 02), and ZZZ is the image number. The image number is 

the very end of the image file name. For example, for image 

120513_155212_1.jpg collected in 2013 on transect 1 the file name would be 

Y13T01I001.csv.  

b. Open image in image J 

i. Select the straight line tool. 

ii. Draw a line between laser points. There are three laser points. You want to use 

the two that are in a vertical line. If they are all lined up, use the inner two.  

1. NOTE: there are images where the laser points are difficult to see, if you 

cannot easily see them zoom in and search the center of the image. If you 

still cannot find the laser points, make a note in the database on the 

Images_not_processed table and do not analyze the image further for 10 

cm grids but DO analyze the image for species present, percent cover (if 

applicable), and osculum counts (again, if applicable). 

iii. Press control M or go to Analyze →Measure. 

iv. The length field in the results box is the number of pixels. Retain this number for 

use in configuring the grid (see c.ii below) 

c. Open image in GIMP 



i. Click on view →show grid 

ii. Click on image →configure grid 

1. Set width and height to be the number of pixels between the lasers 

determined in step b.iv above. 

iii. Record the dominant substrate (≥50% of cell) in each grid cell in the appropriate 

Excel workbook and worksheet using the classifications in Table 1. The substrate 

observation from the top left grid cell in the image should be entered in cell A1 

of the Excel workbook. The remaining observations from the top row should be 

entered in row A of the Excel workbook in sequential order, row two from the 

image should be entered in row B of the workbook, continuing until all rows and 

column of the image have been entered in the workbook. 

iv.  If the substrate in a cell is exactly split between two or more substrates record 

each in the appropriate place, separating each ID with a period (e.g. a cell with 

both wood and bedrock, smooth would be 0.1).   

v. Keep image open in GIMP if recording sponge % cover, otherwise move on to 

next image 

Table 1. Possible substrate classifications 

Substrate Id Substrate Type Substrate Description 

0 Wood Wood, Bark, or Wood Debris 

1 Bedrock, smooth Bedrock, smooth without crevices 

2 Bedrock with crevices Bedrock with crevices 

3 Boulders Boulders, bigger than a basketball 

4 Cobble Cobble, between 3 inches and basketball size 

5 Gravel Gravel, between 3/4 inch and 3 inch 

6 Pea Gravel Pea Gravel, between 1/8 inch and 3/4 inch 

7 Sand Sand 

8 Shell Shell 

9 Mud Mud 

10 Crushed Shell Crushed Shell (new code 2006) 

11 Whole Shell Whole Shell (new code 2006) 

12 Live Reef Sponge Heterochone calyx and Aphrocallistes vastus 

13 Dead Sponge Dead reef building sponges 

14 Boot sponges Rhabdocalyptus spp. 

15 Other sponges All other sponges 

16 Man-made object Marine debris 

17 Non-sponge sessile biota Corals, anemones, etc 

18 Mobile biota Crabs, sea stars, fish, etc 

 

3. Get sponge % cover 

a. Working in GIMP 

i. If the toolbox is not on your screen press control B or go to Windows→toolbox. 



ii. If the tool options dock is not on your screen go to Windows→ Dockable 

dialogues →tool options 

iii. Outline any sponge (live or dead) either using the foreground select tool 

(instructions here) or the free select tool.  

iv. Fill in outline using the colors found in Table 2 using the bucket fill option (Shift 

B). 

1. Make sure to select “fill whole selection” in the “Affected Area” section 

of the tool options. 

2. Change the color to fill by clicking on the color swath at the bottom of 

the tool box.  

v. Once done outlining all sponges, select all filled shapes using the select by color 

tool (Shift O). Select additional colors by holding the shift button.  

 

vi. Once all filled shapes are selected press control I to select the background. Fill 

the background any grey.  

vii. Export file as a .jpg  

b. Open exported file in image J 

i. Go to Image→Adjust→Color Threshold 

ii. Unclick the dark background box at the bottom of the dialogue window that 

opens. 

iii. Use the Wand (tracing) tool to select one filled shape. 

iv. Press sample in the color threshold dialogue window 

1. If all shapes of that color do not automatically turn red adjust the hue, 

saturation, and brightness until all shapes of that color are red. 

v. Press sample in the color threshold dialogue window 

vi. Press control M or go to Analyze →Measure. 

vii. The area in the Results window should be recorded in the appropriate column on 

the Percent Cover table in the database. 

viii. Repeat until all sponge types present in the image are measured. 

 

Table 2. Colors for sponge types in percent cover analysis 

Sponge Type Color 

Reef building sponges (Heterochone calyx and Aphrocallistes vastus)- live Black 

Reef building sponges (Heterochone calyx and Aphrocallistes vastus)- dead Blue 

Rhabdocalyptus spp. White 

Other sponges Orange 

https://docs.gimp.org/en/gimp-tool-foreground-select.html
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